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G1.5 Runs – Form Requirements
G1.5 Runs
Disclosure 5 of the G-1 General Standards requires the modeler to provide information related to
changes in the hurricane model from the previously-accepted hurricane model to the initial
submission of this year. Color-coded maps by county and support files are to be provided that
reflect changes in:
Percentage difference in average annual zero deductible statewide hurricane loss costs
based on 2012 and 2017 CatFund data for each hurricane model component change
Percentage difference in average annual zero deductible statewide hurricane loss costs
based on 2012 and 2017 CatFund data for all hurricane model components change
The following table is a summary of the changes per component under evaluation between the
previously-accepted hurricane model and the model currently set for submission:
Changes under
evaluation

Swaths Roughness (ZIP Vulnerability
(Hurdat) centroid)

ILM Code

Demand Surge Swaths R
(Hurdat) c

Hurdat
Roughness
Hurdat +
Roughness

v6.2
v6.2
v6.2

v6.2
v6.2
v6.2

v6.2
v6.2
v6.2

v6.2
v6.2
v6.2

none
none
none

v6.3
v6.2
v6.3

Year of the
Hurricane (PR
only)

v6.2

v6.2

v6.2

v6.2

none

v6.2

All model
changes
(including YH
impact)

v6.2

v6.2

v6.2

v6.2

none

v6.3

In summary, for November 2018 submission, there is a total of twelve (12) ILM runs:
Two (2) baseline runs, one for each CatFund dataset and v6.2 model inputs
Five (5) runs with each change under evaluation (highlighted in the right side of the table)
with 2012 CatFund data
Five (5) runs with each change under evaluation (highlighted in the right side of the table)
with 2017 CatFund data
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Required files
Several important files are required in order to generate the support files and the color-coded maps
1.- ExcelLoader java program to read the ILM outputs and generate the final form. There are
several versions required in order to generate the output required for the different support files. The
files are located at:
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/code/ExcelLoader/A4/2018_
A4-A7FormsExcelLoader_A4A
This version of the program is built with coverage files for 2012 CatFund data
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/code/ExcelLoader/A4/2018_
A4-A7FormsExcelLoader_A4B
This version of the program is built with coverage files for 2017 CatFund data
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/code/ExcelLoader/G1.5/
The four (4) versions of the program found in this folder have the coverage files
broken down in LR and MHR components for 2012 and 2017 CatFund data
2.- Python notebooks to import data from ILM runs and generate the required files for color-coded
maps. These files are located at:
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/2017FormG1.5/2017FormG1.
5_avg_loss_cost.ipynb
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/2017FormG1.5/2017FormG1.
5_avg_loss_cost_perchange.ipynb
3.- Support file templates. These files are the template for the different support files required.
These files are located at:
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/2017FormG1.5/2017FormG1.
5_supportFile_template.xls
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/2017FormG1.5/2017FormG1.
5_supportFile_PR_MHR_LR_template.xls
4.- File 2017FormA5.xlsx. This file is the template of the form. It is located at:
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/

Processing
WSC runs
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In order to generate the results required for ILM, you have to perform several WSC runs. As
mentioned above, for the November 2018 submission, there is a total of 8 WSC runs. The required
Swaths Files, Roughness Files, Policy File, and WSC code path can be accessed in the following
path:
Files used for WSC runs:
2012 CatFund policy files:
PR:/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFun
d/2012CatFund_PR_agg_a4exp_0deduc.csv
LR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFun
d/2012CatFund_CR_LR_agg_a4exp_0deduc.csv
MHR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatF
und/2012CatFund_CR_MHR_a4exp_0deduc.csv
2017 CatFund policy files:
PR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2017CatFu
nd/processed/2017CatFund_PR_agg_a4exp_0deduc.csv
LR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2017CatFun
d/processed/2017CatFund_CR_LR_agg_a4exp_0deduc.csv
MHR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2017CatF
und/processed/2017CatFund_CR_MHR_a4exp_0deduc.csv
Swaths v6.2:
/home/mitch-a/dmis-projects/fphlm/proc/2015_standards_v6.2/met/swaths/2016041
3_swaths_stochastic_HU20160217_58Kyr/
Swaths v6.3:
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/swaths/2018061
4_swaths_stochastic_HU20180501_59000yrs/
Roughness v6.2:
Roughness: /home/mitch-a/dmisprojects/fphlm/proc/2015_standards_v6.2/met/roughness/rough_popwt_2016/
Distance Tiles: /home/mitch-a/dmisprojects/fphlm/proc/2015_standards_v6.2/met/roughness/distance_popwt_2016/
Roughness v6.3:
Roughness: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/roug
hness/rough_popwt_newvendor_2018/
Distance Tiles: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/r
oughness/distance_popwt_newvendor_2018/
WSC code environment:
/home/mitch-a/dmisprojects/fphlm/proc/2017_standards_v6.3/code/v6.3_wsc_environment
Steps to setup and perform the ILM runs
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1.- Create folders for each combination of the WSC runs in the .../forms/g1-5/folder.
wsc_v6.2_reference_CatFund2012
wsc_v6.2_reference_CatFund2017
wsc_v6.3_hurdat_CatFund2012
wsc_v6.3_hurdat_CatFund2017
wsc_v6.3_roughness_CatFund2012
wsc_v6.3_roughness_CatFund2017
wsc_v6.3_hurdat_roughness_CatFund2012
wsc_v6.3_hurdat_roughness_CatFund2017
2.- Make a copy of the WSC code environment
3.- Enter the code environment you created, modify the wsc_setup.dat file. Each WSC run will
require different parameters setup. Using the Nov 2018 submission as an example, the general
setup that is common to all runs are listed below :
UpdateDatabase="0" WSCRunCount="3" EmailToNotify=
"yxt128@miami.edu" WSCRoot="/home/mitch-a/dmis-projects/fphlm/proc/2017_
standards_v6.3/forms/g1-5/wsc_v6.3_hurdat_roughness_CatFund2012"

Rest of the ilm_setup.dat file setup will change based on the specific run, here we use Nov 2018
submission "WSC v6.3 All Model Changes" run using 2012 CatFund as an example to illustrate.
@WSC1 WSCName="pr_unmatched" PolicyFile="/home/mitch-a/dmis-projects/fphl
m/proc/2017_standards_v6.3/data/2012CatFund/2012CatFund_PR_agg_a4exp_0ded
uc.csv" IndexFieldNumber="16" LongitudeFieldNumber="29" LatitudeFieldNumb
er="30" RoughTiles="/home/mitch-a/dmis-projects/fphlm/proc/2017_standards
_v6.3/met/roughness/rough_popwt_newvendor_2018/" DistanceFolder="/home/mi
tch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/roughness/distance
_popwt_newvendor_2018/" SwathFiles="/home/mitch-a/dmis-projects/fphlm/pro
c/2017_standards_v6.3/met/swaths/20180614_swaths_stochastic_HU20180501_59
000yrs/" NumHeightLevels="1" RoughOpt="0" GustOpt="3" Version="v6_3" Code
Dir="/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/code/v6.3
_wsc_environment_g1-5_tao/code/" RunId="1" @WSC2 WSCName="lr_unmatched"
PolicyFile="/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/da
ta/2012CatFund/2012CatFund_CR_LR_agg_a4exp_0deduc.csv" IndexFieldNumber="
19" LongitudeFieldNumber="20" LatitudeFieldNumber="21" RoughTiles="/home/
mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/roughness/rough_
popwt_newvendor_2018/" DistanceFolder="/home/mitch-a/dmis-projects/fphlm/
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proc/2017_standards_v6.3/met/roughness/distance_popwt_newvendor_2018/" Sw
athFiles="/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/
swaths/20180614_swaths_stochastic_HU20180501_59000yrs/" NumHeightLevels="
1" RoughOpt="0" GustOpt="3" Version="v6_3" CodeDir="/home/mitch-a/dmis-pr
ojects/fphlm/proc/2017_standards_v6.3/code/v6.3_wsc_environment_g1-5_tao/
code/" RunId="2" @WSC3 WSCName="hr_unmatched" PolicyFile="/home/mitch-a/
dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFund/2012CatFund
_CR_MHR_a4exp_0deduc.csv" IndexFieldNumber="21" LongitudeFieldNumber="26"
LatitudeFieldNumber="27" RoughTiles="/home/mitch-a/dmis-projects/fphlm/p
roc/2017_standards_v6.3/met/roughness/rough_popwt_newvendor_2018/" Distan
ceFolder="/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/met/
roughness/distance_popwt_newvendor_2018/" SwathFiles="/home/mitch-a/dmisprojects/fphlm/proc/2017_standards_v6.3/met/swaths/20180614_swaths_stocha
stic_HU20180501_59000yrs/" NumHeightLevels="15" RoughOpt="0" GustOpt="3"
Version="v6_3" CodeDir="/home/mitch-a/dmis-projects/fphlm/proc/2017_stand
ards_v6.3/code/v6.3_wsc_environment_g1-5_tao/code/" RunId="3"

4.- Execute the setupILM.sh
5.- Finally, execute the {WSC run folder}/runWSC.sh script by type and enter nohup ./runWSC.sh &
in the command line.
ILM runs
In order to generate the results required for post-processing, you have to perform several ILM runs.
As mentioned above, for the November 2018 submission, there is a total of 12 ILM runs. The
required Policy File and ILM code path can be accessed from this form: https://goo.gl/aHfgXu
Files used for ILM runs
Files listed below will be used for the 12 ILM runs.
2012 CatFund policy files:
PR:/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFun
d/2012CatFund_PR_agg_a4exp_0deduc.csv
LR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFun
d/2012CatFund_CR_LR_agg_a4exp_0deduc.csv
MHR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatF
und/2012CatFund_CR_MHR_a4exp_0deduc.csv
2017 CatFund policy files:
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PR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2017CatFu
nd/processed/2017CatFund_PR_agg_a4exp_0deduc.csv
LR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2017CatFun
d/processed/2017CatFund_CR_LR_agg_a4exp_0deduc.csv
MHR: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/2017CatF
und/processed/2017CatFund_CR_MHR_a4exp_0deduc.csv
ILM code v6.2:
PR: /home/mitch-a/dmisprojects/fphlm/proc/2015_standards_v6.2/code/v6.2_ilm_pr_Jan2016/ILM
LR: /home/mitch-a/dmisprojects/fphlm/proc/2015_standards_v6.2/code/v6.2_ilm_lr_Jan2016/CRILM_lr
MHR: /home/mitch-a/dmis-projects/fphlm/proc/2015_standards_v6.2/code/v6.2_ilm_
mhr_Jan2016/CRILM_mhr
ILM code v6.3:
Note: for the Nov 2018 submission, we switched to 32 threads version ILM code.
This only affects the PR code. Use the default path for LR and HR ILM code is
applicable.
PR: /home/mitch-a/dmisprojects/fphlm/proc/2017_standards_v6.3/code/v6.3_ilm_pr_32threads/ILM
Steps to setup and perform the ILM runs
1.-Create a folder with the name of the current date in the .../forms/g1-5/folder. (for example:
.../forms/g1-5/20181011_run)
2.-Make a copy of the ILM code environment /home/mitch-a/dmisprojects/fphlm/proc/2017_standards_v6.3/code/v6.3_ilm_env/ in the newly created
.../forms/g1-5/{current date} folder
3.-For each run, create a folder with the naming convention of {Date}{ILM reference version}{run
purpose}_{CatFund version}. For example, for a run performed on Oct 11, 2018, using ILM v6.2 as
reference for the all model changes using 2012 Catfund, the folder will be named
as 20181011_ilmv6.2_AllModelChanges_2012CatFund.
4.-Enter the code envirnment you created, modify the ilm_setup.dat file. Each ILM run will require
different parameters setup. Using the Nov 2018 submission as an example, the general setup that
is common to all runs are listed below :
ILMRunCount="3" DataSource="FL OIR" EmailToNotify="{your email address}"
ILMRoot="/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/forms
/g1-5/20181011_run/{specific ILM run folder}" PR_M_FLAG="0" PR_UM_FLAG="1
" HR_M_FLAG="0" HR_UM_FLAG="1" LR_M_FLAG="0" LR_UM_FLAG="1" CodeDir="/hom
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e/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/code/v6.3_ilm_env_
g1-5_tianyi/code/"
Note that only the PR_UM_FLAG, HR_UM_FlAG and LR_UM_FLAG are set. This is the
case for all runs EXCEPT for "Year of the Hurricane" runs, which only require the
PR_U_FLAG to be set to 1 andILMRunCount set to 1.
Also, note that the CodeDir parameter is set to the .../code/... directory. This is not
recommended for future runs because this will cluster the ../code/... folder. It is
recommended to setup the code environment as illustrated in step 2.
5.-Rest of the ilm_setup.dat file setup will change based on the specific run, here we use Nov 2018
submission "ILM v6.3 All Model Changes" run using 2012 CatFund as an example to illustrate.
Note only the fields that require modification are listed. You can ignore other parts of the script.
@ILM1 ID="PR_unmatched" ILMName="pr_unmatched" PolicyFile="/home/mitch-a/
dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFund/2012CatFund
_PR_agg_a4exp_0deduc.csv" Winds="/home/mitch-a/dmis-projects/fphlm/proc/2
015_standards_v6.2/data/winds/2013_zip_centroids_v6.2_stochastic_winds_58
Kyrs/2013_all_zip_centroids_1_v6_2/merged/" StochasticSet="1" DetailedOut
put="0" CountySurge="0" TypeOfMatrices="1" UseRetrofitting="1" Matrices="
/home/mitch-a/dmis-projects/fphlm/proc/2015_standards_v6.2/eng/matrices_c
urves/pr_matrices/20160720/processed/final_all_csv/" ProgramOption="s_pre
setDS_threads" RunId="1" RefYear="2013"
The above code block is the setup for pr unmached run. The PolicyFile parameter is set to
match the version of the policy file. Either 2012 CatFund PR or 2017 CatFund PR
The RefYear parameter needs to be set to 2013if using 2012 CatFund, or 2017if using
2017 CatFund.
Set CountySurge to "0"
The Winds parameter needs to be set using the wind generated by the WSC runs
mentioned above. Below will list the path for PR for all the 12 ILM runs for Nov 2018
submission:
ilmv6.3 Hurdat 2012CatFund: /home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/wsc_v6.3_hurdat_CatFund2012/pr_unmatched_1_v6_3/merged
/
ilmv6.3 Hurdat 2017CatFund: /home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/wsc_v6.3_hurdat_CatFund2017/pr_unmatched_1_v6_3/merged
/
ilmv6.3 Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_sta
ndards_v6.3/forms/g1-5/wsc_v6.3_roughness_CatFund2012/pr_unmatched_1_v6_
3/merged/
ilmv6.3 Roughness 2017CatFund: /home/mitch-a/dmis-projects/fphlm/proc/2017_st
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andards_v6.3/forms/g1-5/wsc_v6.3_roughness_CatFund2017/pr_unmatched_1_v6
_3/merged/
ilmv6.3 Hurdat+Roughness 2012CatFund: /home/mitch-a/dmis-projects/fphlm/proc/
2017_standards_v6.3/forms/g1-5/wsc_v6.3_hurdat_roughness_CatFund2012/pr_un
matched_1_v6_3/merged
ilmv6.3 Hurdat+Roughness 2017CatFund: /home/mitch-a/dmis-projects/fphlm/proc/
2017_standards_v6.3/data/winds/2017_zip_centroids_stochastic_winds_59000yrs/2
017_all_zip_centroids_1_v6_3/merged/
ilmv6.3 Year of the Hurricane 2012CatFund: /home/mitch-a/dmis-projects/fphlm/pro
c/2015_standards_v6.2/data/winds/2013_zip_centroids_v6.2_stochastic_winds_58
Kyrs/2013_all_zip_centroids_1_v6_2/merged/
ilmv6.3 Year of the Hurricane 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc
/2017_standards_v6.3/forms/g1-5/wsc_v6.2_reference_CatFund2017_noalexc/pr_u
nmatched_1_v6_2/merged/
ilm6.3 All Model Changes 2012CatFund: /home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/data/winds/2013_zip_centroids_stochastic_winds_59000yrs/201
3_all_zip_centroids_1_v6_3/merged/
ilm6.3 All Model Changes 2017CatFund: /home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/data/winds/2017_zip_centroids_stochastic_winds_59000yrs/201
7_all_zip_centroids_1_v6_3/merged/
ilm6.2 All Model Changes 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
15_standards_v6.2/data/winds/2013_zip_centroids_v6.2_stochastic_winds_58Kyrs/
2013_all_zip_centroids_1_v6_2/merged/
ilm6.2 All Model Changes 2017CatFund: /home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/wsc_v6.2_reference_CatFund2017_noalexc/pr_unm
atched_1_v6_2/merged/
@ILM2 ID="LR_unmatched" ILMName="lr_unmatched" PolicyFile="/home/mitch-a/
dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFund/2012CatFund
_CR_LR_agg_a4exp_0deduc.csv" Winds="/home/mitch-a/dmis-projects/fphlm/pro
c/2017_standards_v6.3/data/winds/2013_zip_centroids_stochastic_winds_5900
0yrs/2013_all_zip_centroids_1_v6_3/merged/" StochasticSet="1" DetailedOut
put="0" CountySurge="0" TypeOfMatrices="1" Matrices="/home/mitch-a/dmis-p
rojects/fphlm/proc/2015_standards_v6.2/eng/matrices_curves/lr_curves/2016
0618/processed/final_all_csv/" ProgramOption="s_presetDS_threads" RunId="
2" RefYear="2013"
The above code block is the setup for LR unmatched run. The PolicyFile parameter is set
to match the version of the policy file. Either 2012 CatFund PR or 2017 CatFund PR
The RefYear parameter needs to be set to 2013if using 2012 CatFund, or 2017if using
2017 CatFund.
Set CountySurge to "0"

8 / 19

FPHLM Wind
https://fphlmdoc.cs.fiu.edu

The Winds parameter needs to be set using the wind generated by the WSC runs
mentioned above. Below will list the path for PR for all the 12 ILM runs for Nov 2018
submission:
ilmv6.3 Hurdat 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/wsc_v6.3_hurdat_CatFund2012/lr_unmatched_2_v6_3/merged/
ilmv6.3 Hurdat 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/wsc_v6.3_hurdat_CatFund2017/lr_unmatched_2_v6_3/merged/
ilmv6.3 Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_sta
ndards_v6.3/forms/g1-5/wsc_v6.3_roughness_CatFund2012/lr_unmatched_2_v6_3
/merged/
ilmv6.3 Roughness 2017CatFund: /home/mitch-a/dmis-projects/fphlm/proc/2017_st
andards_v6.3/forms/g1-5/wsc_v6.3_roughness_CatFund2017/lr_unmatched_2_v6_
3/merged/
ilmv6.3 Hurdat+Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2
017_standards_v6.3/forms/g1-5/wsc_v6.3_hurdat_roughness_CatFund2012/lr_unm
atched_2_v6_3/merged
ilmv6.3 Hurdat+Roughness 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2
017_standards_v6.3/data/winds/2017_zip_centroids_stochastic_winds_59000yrs/20
17_all_zip_centroids_1_v6_3/merged/
There's no LR runs for ilmv6.3 Year of the Hurricane 2012CatFund, set the first line
@ILM2 to @ILM#
There's no LR runs for ilmv6.3 Year of the Hurricane 2017CatFund, set the first line
@ILM2 to @ILM#
ilm6.3 All Model Changes 2012CatFund: /home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/data/winds/2013_zip_centroids_stochastic_winds_59000yrs/201
3_all_zip_centroids_1_v6_3/merged/
ilm6.3 All Model Changes 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/data/winds/2017_zip_centroids_stochastic_winds_59000yrs/201
7_all_zip_centroids_1_v6_3/merged/
ilm6.2 All Model Changes 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
15_standards_v6.2/data/winds/2013_zip_centroids_v6.2_stochastic_winds_58Kyrs/
2013_all_zip_centroids_1_v6_2/merged/
ilm6.2 All Model Changes 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/wsc_v6.2_reference_CatFund2017_noalexc/lr_unm
atched_2_v6_2/merged/

@ILM3 ID="HR_unmatched" ILMName="hr_unmatched" PolicyFile="/home/mitch-a/
dmis-projects/fphlm/proc/2017_standards_v6.3/data/2012CatFund/2012CatFund
_CR_MHR_a4exp_0deduc.csv" Winds="/home/mitch-a/dmis-projects/fphlm/proc/2
015_standards_v6.2/data/winds/2013_zip_centroids_v6.2_stochastic_winds_58

9 / 19

FPHLM Wind
https://fphlmdoc.cs.fiu.edu

Kyrs/2013_all_zip_centroids_1_v6_2/merged/" StochasticSet="1" OutputPerSt
orm="0" OutputRiskLevelLoss="1" DemandSurge="0" PRPolicyFlag="0" Matrices
="/home/mitch-a/dmis-projects/fphlm/proc/2013_standards_v6.0/data/matrice
s_curves/v6.0_mhr_curves/" NumColumns="28" PolicyCol="Pol-1" LocationCol=
"Loc-2" ZipcodeCol="Zip-3" YearCol="Year-4" CoverageCol="Vi-5" LMsCol="LM
s-6" LMappCol="LMapp-7" LMcCol="LMc-8" LMaleCol="LMale-9" DeductibleCol="
Deduc-10" HurrDeductibleCol="HurrDeduc-11" CountyCol="County-12" RegionCo
l="Region-13" NumUnitsCol="NumUnits-14" NumStoriesCol="NumStories-15" Sto
ryNumCol="StoryNum-16" ShutterCol="Shutter-17" SlidingDoorCol="SlidingDoo
r-18" TypeOfRiskCol="TypeOfRisk-19" LayoutCol="Layout-20" WSCIndexCol="WS
CIndex-21" ProgramOption="crh" RunId="3" RefYear="2013"
The above code block is the setup for HR unmatched run. The PolicyFile parameter is set
to match the version of the policy file. Either 2012 CatFund PR or 2017 CatFund PR
The RefYear parameter needs to be set to 2013if using 2012 CatFund, or 2017if using
2017 CatFund.
Set CountySurge to "0"
The Winds parameter needs to be set using the wind generated by the WSC runs
mentioned above. Below will list the path for PR for all the 12 ILM runs for Nov 2018
submission:
ilmv6.3 Hurdat 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/wsc_v6.3_hurdat_CatFund2012/hr_unmatched_3_v6_3/merged
/
ilmv6.3 Hurdat 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/wsc_v6.3_hurdat_CatFund2017/hr_unmatched_3_v6_3/merged
/
ilmv6.3 Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_sta
ndards_v6.3/forms/g1-5/wsc_v6.3_roughness_CatFund2012/hr_unmatched_3_v6_
3/merged/
ilmv6.3 Roughness 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_sta
ndards_v6.3/forms/g1-5/wsc_v6.3_roughness_CatFund2017/hr_unmatched_3_v6_
3/merged/
ilmv6.3 Hurdat+Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2
017_standards_v6.3/forms/g1-5/wsc_v6.3_hurdat_roughness_CatFund2012/hr_un
matched_3_v6_3/merged
ilmv6.3 Hurdat+Roughness 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2
017_standards_v6.3/data/winds/2017_zip_centroids_stochastic_winds_59000yrs/20
17_all_zip_centroids_1_v6_3/merged/
There's no HR runs for ilmv6.3 Year of the Hurricane 2012CatFund, set the first line
@ILM3 to @ILM#
There's no HR runs for ilmv6.3 Year of the Hurricane 2017CatFund, set the first line
@ILM3 to @ILM#
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ilm6.3 All Model Changes 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/data/winds/2013_zip_centroids_stochastic_winds_59000yrs/201
3_all_zip_centroids_1_v6_3/merged/
ilm6.3 All Model Changes 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/data/winds/2017_zip_centroids_stochastic_winds_59000yrs/201
7_all_zip_centroids_1_v6_3/merged/
ilm6.2 All Model Changes 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
15_standards_v6.2/data/winds/2013_zip_centroids_v6.2_stochastic_winds_58Kyrs/
2013_all_zip_centroids_1_v6_2/merged/
ilm6.2 All Model Changes 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/wsc_v6.2_reference_CatFund2017_noalexc/hr_unm
atched_3_v6_2/merged/
6.-For runs involve V6.2 Hurdat, modify the 13th line of the script in your code environment
.../code/hr_combined/code/get_combined_results.sh from yearsOfSimulation=59000 to
yearsOfSimulation=58000
7.- Execute the setupILM.sh file by typing ./setupILM.shin the command line and hit enter. The
running environment will be created in the specific ILM run folder created in step 2.
8.- For runs involve V6.2 Hurdat,
Change The third line of file from_to_stochastic.txt in {ILM run folder}/pr_unmached/env
and {ILM run folder}/lr_unmached/env to 58000
{ILM run folder}is the specific ILM run folder you created in step 2.
Replace the soft link in {ILM run folder}/combined/storm_mapping.txt to /home/mitch-a/dmis
-projects/fphlm/proc/2015_standards_v6.2/code/v6.2_ilm_env/code/combined/storm_mappi
ng_stochastic.txt from the 2015 submission.
9.-Choose the correct version of ILM code from the requirement table, set up the correct path for
the ILM code in {ILM run folder}/pr_unmatched/env/, {ILM run folder}/lr_unmatched/env/and {ILM
run folder}/hr_unmatched/using the paths in the Required Files section.
10.- Finally, execute the {ILM run folder}/runILM.shscript by type and enter nohup ./runLM.sh & in
the command line.

Notes
The ILM run environments are located at:
ilmv6.3 Hurdat 2012CatFund: /home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_hurdat_2012CatFund/
ilmv6.3 Hurdat 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_standar
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ds_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_roughness_2017CatFund/
ilmv6.3 Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_sta
ndards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_roughness_2012CatFun
d/
ilmv6.3 Roughness 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2017_sta
ndards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_roughness_2017CatFun
d/
ilmv6.3 Hurdat+Roughness 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2
017_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_hurdat_roughne
ss_2012CatFund/
ilmv6.3 Hurdat+Roughness 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/2
017_standards_v6.3/forms/g1-5/20181011_run/20181015_ilmv6.3_hurdat_roughne
ss_2017CatFund/
ilmv6.3 Year of the Hurricane 2012CatFund: /home/mitch-a/dmis-projects/fphlm/pro
c/2017_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_YearOfHurric
ane_2012CatFund/
ilmv6.3 Year of the Hurricane 2017CatFund: /home/mitch-a/dmis-projects/fphlm/pro
c/2017_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_YearOfHurric
ane_2017CatFund/
ilm6.3 All Model Changes 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_AllModelChanges
_2012CatFund/
ilm6.3 All Model Changes 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_AllModelChanges
_2017CatFund/
ilm6.2 All Model Changes 2012CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.2_AllModelChanges
_2012CatFund/
ilm6.2 All Model Changes 2017CatFund:/home/mitch-a/dmis-projects/fphlm/proc/20
17_standards_v6.3/forms/g1-5/20181011_run/20181011_ilmv6.2_AllModelChanges
_2017CatFund/

Post-processing
In order to create the files required for the support files, you have to simulate a post-processing run
as if it were for Form A5. The zero deductible log outputs of the ExcelLoader program will be the
inputs to the support files.
Create a folder to hold the intermediate files that will result from this process. Named
20181102 in this example
Steps to create the files with the results required to create the support files
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1.- Create a folder to hold the intermediate files for a specific change under evaluation
(v6.3_hurdat_ilm_6.2_2012CatFund, v6.3_roughness_ilm_6.2_2012CatFund, and so on...)
2.- Within the recently created folder create another folder to contain the files and folders required
to generate the required outputs. Named gen_excel_file in this example
3.- Within gen_excel_file create the following folders:
log
v6.2_aal
v6.3_aal
4.- Within v6.2_aal and v6.3_aal create the following directory structure:
Zero_Deductible/Combined/results/
Specific_Deductible/Combined/results/
You can skip the creation of Specific_Deductible folder since we only care about
Zero_Deductible. In that case, only create Zero_Deductible and create a symlink
named Specific_Deductible pointing to Zero_Deductible
5.- For each v6.2_aal and v6.3_aal folders, copy or symlink the file final_all.txt from the combined
folder of the versions' corresponding runs.
v6.2_aal folder will always have files from the baseline run that correspond to each
CatFund dataset
v6.3_aal folder will always have files from the run with the change under evaluation that
corresponds to each CatFund dataset
As an example, for 2018 November submission and hurdat change with 2012CatFund data,
the structure would be as follows:
For v6.2_aal:
Zero_Deductible: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v
6.3/forms/g1-5/20181011_run/20181011_ilmv6.2_AllModelChanges_2012C
atFund/combined/results/final_all.txt
For v6.3_aal:
Zero_Deductible: /home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v
6.3/forms/g1-5/20181011_run/20181011_ilmv6.3_hurdat_2012CatFund/com
bined/results/final_all.txt
6.- Copy A5 form template and the corresponding ExcelLoader program into the gen_excel_file
directory
When creating files for 2012 CatFund data use ExcelLoader_A4A
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When creating files for 2017 CatFund data use ExcelLoader_A4B
There will be occasions where the Commercial_Residential portion of the support file needs
to be broken down in LR and MHR components, in which case you need to use the
corresponding ExcelLoader located at:
/home/mitch-a/dmisprojects/fphlm/proc/2017_standards_v6.3/code/ExcelLoader/G1.5/
7.- The resulting directory structure and files of gen_excel_file folder should be something similar to
this:
v6.2_aal/Zero_Deductible/Combined/results/final_all.txt
v6.2_aal/Specific_Deductible/Combined/results/final_all.txt
v6.3_aal/Zero_Deductible/Combined/results/final_all.txt
v6.3_aal/Specific_Deductible/Combined/results/final_all.txt
log
ExcelLoader_you_version.jar file
2017FormA5.xlsx
8.- Run the Java program in the command line as follows:
Syntax: java -jar ExcelLoader_your_version.jar -a5 AllOptions A5_template.xlsx
path_to_aal_6.2_folder/ path_to_aal_6.3_folder/ output_file.xlsx path_log_folder/
Example: java -jar ExcelLoader_FormsA4-7-FPHLM_v5.0.jar -a5 AllOptions
2017FormA5.xlsx v6.2_aal/ v6.3_aal/ 20181008_FormA5.xlsx log/
9.- If the program runs without any issues, the log/logs_zero_deductible folder should have all the
results required for the support file
10.- Repeat the steps for all changes under evaluation
Steps to create the support files
1.- Copy the corresponding support file template to the post-processing root directory,
20181102/change_under_evaluation
2.- Open the template with Microsoft Excel
3.- Go to gen_excel_file folder, then logs_zero_deductible
4.- Notice how the support file template has two sets of columns in each of the sheets. The
columns on the left will hold data from the files within the logs_older_set folder. The columns on the
right will hold data from the files within the logs_newer_set folder.
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5.- Also notice the sheet names, each one of them will be filled with the data from the respective
log files. For example, Owners_Frame sheet will have data from zipcode_losscosts_OwnersFrame.csv. As mentioned in the previous step, the left side contains data from logs_older_set and
the right side contains data from logs_newer_set
6.- To add the data into the sheets follow the following steps:
Open the log file
Copy the values from County, Zipcode, Coverage, and LossCosts columns and paste into
county, zipcode, exposure, and wt_tot columns, respectively
In the first cell of form_construction column insert the sheet name and double click in the
autofill tool (bottom right corner) to fill the rest of the column's cells with the same value
Add a zero (0) in the first cell of deductible column. Double click the autofill tool to fill the
rest of the columns with zero
For columns region and coastal_inland, open a previous submission support file and use
Excel's VLOOKUP function to get the corresponding value based on the county name
You only need to do this process for the left side, then copy values from all columns except
wt_tot to the right side. Values for wt_tot in the right side comes from the LossCosts column
in the log file in logs_newer_set
7.- Repeat step 6 for all construction types
Please note that the number of rows between different construction types varies, so you
cannot copy and paste the rows between different sheets
8.- Repeat the steps for all changes under evaluation
Steps to create the required files for the color-coded maps
1.- Use Anaconda Navigator or an existing Jupyter Notebook or Jupyter Lab environment and
open:
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/2017FormG1.5/2017FormG1.
5_avg_loss_cost.ipynb
The program reads the final_all.txt file and generates the average loss cost at the county level
based on the losses and units per county
Change the paths to point to the correct final_all.txt file
Change the path of the output file. Ideally, you will save the output file in the folder with the
intermediate files for the change under evaluation
Run all the cells
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As a precaution, you can comment the last cell and test the output first before
saving to a file
If everything looks ok, proceed to save the output .csv file
The format of the output .csv file is as follows:
County, Units in County, Loss Cost per County, Avg Loss Cost per Unit in County
You will need to perform this process only once for the baseline run and once for each change
under evaluation. As an example, you can check the baseline for 2018 November submission in
the following paths:
2012 CatFund baseline is located at: /home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/post-processing/v6.2_all_model_changes_ilm6.2_2012CatFund/20181
022_avg_loss_cost_per_unit_county.csv
2017 CatFund baseline is located at: /home/mitch-a/dmis-projects/fphlm/proc/2017_standar
ds_v6.3/forms/g1-5/post-processing/v6.2_all_model_changes_ilm6.2_2017CatFund/20181
023_avg_loss_cost_per_unit_county.csv
After generating all the required outputs, you should have twelve (12) .csv files with the
aforementioned output
2.- Use Anaconda Navigator or an existing Jupyter Notebook or Jupyter Lab environment and
open:
/home/mitch-a/dmis-projects/fphlm/versions/v6.3/2017_ROA/2017FormG1.5/2017FormG1.
5_avg_loss_cost_perchange.ipynb
This program reads the outputs of the previous program, calculates the percentage change, and
outputs a .csv file ready to be used to create the map
Change the paths to point to the corresponding baseline and change under evaluation .csv
files generated in the previous step
You would set the path to the baseline file just once and change only the path of the
losses for the change under evaluation
Change the path of the output file. Ideally, you will save the output file in the folder with the
intermediate files for the change under evaluation
Run all the cells
As a precaution, you can comment the last cell and test the output first before
saving to a file
If everything looks ok, proceed to save the output .csv file
The format of the output .csv file is as follows:
County, Percentage
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Steps to create the maps
The maps for Form G1.5 detail percentage change at the county level. The shapefile used to
generate this map is located in:
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/data/base_maps/fl_2011_co
unties/cntbnd_jul11.shp
1.- Open ArcMap and create a new empty map
In the left panel, right click on Layers and then Add Data...
Select the aforementioned shapefile. The right panel should now display the map of Florida
with county boundaries
Repeat the process to Add Data..., but this time select the .csv files generated in the
previous step
In the left panel:
Right click on the map layer (cntbnd_jul11 or the name of the loaded shapefile) >
Properties... > Join & Relates > Add...
In the popup, on field 1. Choose the field in this layer that the join will be based
on: select NAME or the attribute in the shapefile that correspond to the county name
Once selected, field 3. Choose the field in the table to base the join on: select
County if it is not automatically selected
Click Ok. You should now see an entry under the Joins panel at the left
Go to the Symbology tab, then click on Quantities
In the Import Symbology Matching Dialog, select Percentage as the Value Field,
then click OK
You should follow the maps from last submission to set a customized color ramp,
ranges, and labels for each range
Click Apply then OK
If everything went smoothly the map should be colored now according to the loaded color
ramp.
Now change the view to Layout View. View > Layout View
If the map is not centered in the document, click on the Full Extent tool in the toolbar. The
button is represented by a globe
Insert Title and Legends
For the title: Click on Insert > Title and type the desired title. Properties of the title
can be changed through a double click over the title in the document. Set the
appropriate format
For the legend: Click on Insert > Legend. Hit Next for all steps. You should see a
legend over the document now
Position the legend at the bottom left of the document
Resize accordingly
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To change the caption of the legend, select the label under the map
shapefile layer (cntbnd_jul11 or the name of the loaded shapefile), click to
enter edit mode and delete the text if any. Then select and click over the
shapefile layer to enter edit mode and change the caption to Percentage
For Min and Max legend: Click on Insert > Text
Change text to: Min: Open, then sort by Percentage by right-clicking
over the column header and selecting either Sort Ascending or Sort
Descending
Place the legend at the bottom right of the document
Place an * over the counties with Min and Max percentage change.
Save the current document as an ArcMap document (.mxd). File > Save as...
Export the current document as a PNG file. File > Export Map... Set resolution to 600 dpi
Once the first map is finished and the document has been saved as an ArcMap document, the
process can be repeated for the remaining changes under evaluation maps using the same
document and changing the data source, join, title, and legends accordingly.
Save each map as a separate ArcMap document.
Results
1.- Send prototype of form to the verifier.
2.- Verifier sends prototype of form to team leader.
3.- Team leader sends prototype of form to expert.

Notes
The post-processing environments for the results submitted in November 2018 are located
at:
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/forms/g1-5/postprocessing/
The outputs generated for November 2018 submission can be found at:
/home/mitch-a/dmis-projects/fphlm/proc/2017_standards_v6.3/forms/g1-5/outputs/
The data underlying the maps for November 2018 submission can be found at:
/home/mitch-a/dmisprojects/fphlm/proc/2017_standards_v6.3/forms/g1-5/outputs/map_data/
There will be occasions that support files will be required to have
the Commercial_Residential component separated into LR and MHR components, if that is
the case:
If the exposure data changes, you need to request new separated coverage files for
LR and MHR components and create new versions of the ExcelLoader program. If
the data doesn't change, you can use the ones mentioned in section 1.1
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The coverage files contain the aggregated exposures at zip code level
It is a .csv file without header with the following format:
zipcode,LMs,LMapp,LMc,LMale,Total_Coverage
Instructions to build a new version of the program are located at: /home/mitc
h-a/dmisprojects/fphlm/proc/2017_standards_v6.3/code/ExcelLoader/README
You need to run the ExcelLoader program separately for LR and MHR component,
specifically you need to:
Create a new folder with v6.2_aal, v6.3_aal, log folders, Form A5 template
file, and the corresponding ExcelLoader program
This time, instead of copying or linking final_all.txt file, you need to copy or
link lr_aal.txt or mhr_aal.txt as final_all.txt and then run the ExcelLoader
program for each of the components.
The file log/logs_zero_deductible/{logs_older_set,logs_newer_set}/zipcode_l
osscosts_CommercialResidential.csv will give you the values required for
the wt_tot column of the given component
Additionally, there will be occasions that maps and support files will be required for runs
with DemandSurge. If that is the case:
Files from the ILM run for Form A4A and A4B can be used as runs with 2012 and
2017 CatFund data, respectively
For November 2018 submission, an additional ILM run using 2017 CatFund data
was performed, but with v6.2 model inputs, since there wasn't any ILM run with v6.2
model inputs, 2017 CatFund data, and DemandSurge enabled
All the files and configurations in this document are specific to this example run and
submission. The processor should update parameters as required by the submission and/or
version.
The outputs of the Python notebooks used in Section 1.3.3 to generate the files for colorcoded maps are specific to the data in the shapefile used in this submission. You need to
take appropriate measures based on the shapefile you will work on.
You need to be aware of the format of the output in order for the Join operation to
be successful. Ideally, a join operation through a zip code attribute would be less
prone to error, unfortunately, the shapefile of the base map didn't include that
information, so the join operation had to be performed over the column with the
county name
As a rule of thumb, you need to generate the .csv or Excel file with a column that
will serve to join the data with the shapefile, either by zip code or county name
The results and maps showing the impact of each individual model change that were
submitted in November 2018 did not contain demand surge; however, the result and map
showing the impact of all model changes combined that were submitted did contain
demand surge for agreement with Form A-5's results.
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